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Overview

Digital Studio is a MIDI sequencer that allows you to record, edit and play MIDI data.

In Digital Studio the basic unit of music is called the segment. A segment can be moved, repeated, split,

combined with another segment or copied. A segment can also be cloned which gives multiple instances
of a segment. In this case any change made in a segment will result in the same change being made in

all the other instances of the segment.

A segment can be edited in various ways. The Score View allows you to edit in standard music notation.
The Piano Roll View displays the notes as rectangles on a grid. The width of the rectangle depends on
the length of the note while the position of the rectangle depends on the pitch and time of the note. The
Drum View is similar to the Piano Roll View except the notes are displayed as diamonds. The Event List
View displays the events as a list while the Controllers View displays the events for a single controller as
a list. The Quantize View displays the sections of the segment that have been quantized. To display a
view highlight a segment in the Track View by clicking on it and then choose a view from the View Menu.
Any changes made in these views will also be made to any other instances of the segment.

Each segment also has various attributes that can be changed in the Track View or in the Segment
Settings dialog box. To change the settings in the Track View, highlight a segment by clicking on it. Its
settings will now be displayed at the top of the Track View. Pressing the left mouse button on a value will
decrease it while pressing the right mouse button on a value will increase it. To display the Segment
Settings dialog box double click on a segment in the Track View. If the length of the segment or its name
is changed then the same change will be made in any other instances of the segment. All the other
settings are unique to each instance of the segment.

A segment is copied by clicking the right mouse button on a segment in the Track View and then dragging
it to the new position. If the Copy As Clone option is checked in the Track View Options then the new
segment is a clone of the segment being copied and thus any changes made to either of these segments
will result in the same change being made to the other. If the Copy As Clone option is not checked then
the new segment will not be related to the segment being copied and thus any changes made to either of
these segments will not affect the other. To create an empty segment choose Create Segment from the
Edit Menu.



Tutorial

This tutorial gives an introduction to some of the most commonly used functions in Digital Studio.

First of all, you have to decide which MIDI devices to use. Click on the MIDI menu and select MIDI
Devices. This displays a dialog box where you can select the input and output devices that you wish to
use. The input devices are used for recording and the output devices for playback. A device can be
selected or unselected by clicking on its name. Once you have selected which devices you wish to use
click on OK. If you get a message saying that a particular device is unable to be opened this is probably
because it is already open in another program. Deselect the device that cannot be opened and click on
OK again.

Click on the File menu and select Open. Select fanfare.dst and click on OK. You should now see
information about the song in the Track View. The song is split into tracks with each line in the Track View
representing a track. In the left pane of the Track View information is displayed about the track such as
the Name, Port, Channel and Patch. Each track is then split into segments. A segment represents a
section of music. These are displayed in the right pane. If the cursor is moved over the bar between the
two panes the cursor changes shape. If the left mouse button is then pressed and held down, moving the
mouse left or right moves the position of the bar. This enables you to decide how much of each pane you
wish to view.

To play the song either click on the Play button(the button with a single blue arrow) or press the space
bar. If you cannot hear anything, change the Port for each track by clicking the right mouse button in the
Port column in the Track View. This cycles through the MIDI Output Devices that were selected earlier.
Clicking the right mouse button moves forward through the list of devices and clicking the left mouse
button moves backwards through the list. The rest of the columns after the Port column react in a similar
way, clicking the right mouse button increases the value and clicking on the left mouse button decreases
the value. To change the name of the track, double-click on the name. This will display a dialog box which
also allows you to change other parameters for the track.

If the patch column is empty click on the MIDI menu and select Instrument Map. This displays a dialog
box which allows you to select an Instrument for each channel of each output device. Select the device
which was selected in the Port column previously and then select an Instrument which corresponds to the
device for each channel. If your Instrument is not included in the list you can create an Instrument in the
Define Instruments dialog box. You can also create a set of patch names for an Instrument in the Define
Names dialog box. Both of these dialog boxes are selected from the MIDI menu. Once you have selected
an Instrument for each channel you should then be able to change the patch in the Track View.

The right pane of the Track View displays the segments. If you click on a segment it should then become
selected and information about the segment is displayed in the boxes at the top of the Track View.
Clicking the right mouse button on a box increases the value while clicking the left mouse button
decreases the value. Double-clicking on the segment or on the Name box brings up a dialog box which
also allows you to change the settings for the segment. If you press the left mouse button on the segment
and then drag it while keeping the button pressed the segment is then moved. If you do the same thing
except with the right mouse button the segment is copied.

There are a number of ways to view the notes in a segment. A segment must be selected before the
notes in it can be viewed. Once this is done, click on the View Menu and select Score. Displaying
information about the note, moving and copying a note is identical to how you manipulated the segments.
To insert a note just click the mouse button where you wish to place the note. To change what type of note
is inserted click on the button. This displays a dialog box in which you can also change which clefs are
displayed and at what resolution the notes are displayed. To erase a note click on the button. This
changes the cursor shape and then simply click on a note to delete it.

You can also view the notes in the Piano Roll View. This is displayed by clicking on the View Menu and
selecting Piano Roll. This displays notes as a rectangle with the width of the rectangle determined by the
length of the note. Manipulating notes is similar to the Score View. In addition you can change the length



of the note by placing the cursor over the right edge of the rectangle. The cursor will change shape and
then by pressing and holding the left mouse button and moving the mouse either left or right you can
change the length of the note.

This has shown you just a glimpse of the capabilities of Digital Studio. The best way to discover what else
is available is to experiment. If you are ever unsure of what you can do in a view, press F1 and help is
given on whatever you are currently viewing.



MIDI Basics

Digital Studio is a MIDI sequencer that allows you to record, edit and play MIDI data.
MIDI stands for Musical Instrument Digital Interface. It allows MIDI-equipped devices to communicate with
each other via messages.

There are three types of MIDI connectors, MIDI In, MIDI Out and MIDI Thru. Information is sent via a MIDI
cable from the MIDI Out on one device to the MIDI In on another device. Most soundcards and MIDI
interfaces have just a MIDI In and a MIDI Out. However, other devices such as synthesizers also have a
MIDI Thru connector. In this case any information received at the MIDI In is repeated from the MIDI Thru.
This means that information can be sent to more than one instrument at a time.To be able to transmit
messages MIDI includes 16 channels. Information can be sent via these 16 channels separately. So with
one MIDI cable, 16 parts can be played at the same time. A MIDI instrument can be set up so that it only
receives messages on certain channels and ignores the rest. MIDI messages

There are two different types of messages, channel messages and system messages.
Channel messages are sent via a specific MIDI channel. They include

Note On. This is used to indicate the beginning of a MIDI note. It tells the instrument what note to play
and how loud to play the note.

Note Off. This is used to tell an instrument to stop playing a MIDI note. It tells it which note and also the
release velocity. The release velocity is used to vary the note's speed of decay but few instruments
actually respond to it.

Key Aftertouch. By pressing a key harder after initially playing it a Key Aftertouch message is generated.
Depending on the instrument this can control performance parameters such as vibrato, volume and pitch.
Not all instruments generate or respond to this message.

Channel Aftertouch. This is similar to Key Aftertouch except that it is applied to all keys and not a
specific one.

Program Change. This is used to change the sound patch of an instrument.

Pitch Bend. This is used to change the pitch of notes. A positive number increases the pitch and a
negative number decreases the pitch.

Control Change. This is used to change performance parameters of an instrument such as modulation,
sustain pedal, pan and volume. Most instruments only respond to a small number of these.

System messages are not channelised and are used to control the whole MIDI system. For example, they
can be used to synchronize a sequencer and a drum machine so that they play exactly in time with each
other, start and stop songs or to reset a system. They also include system exclusive messages. These
messages are exclusive to a particular manufacturer and include an ID number. This means that any
system exclusive data received with a different ID number from its own will be ignored. System exclusive
data can be used to store sounds from a synthesizer.

MIDI Modes

A MIDI device can be in one of four receiving modes:

Mode 1. Omni On, Poly. In this mode a device is able to play more than one note at a time and it
responds to all MIDI channel messages, regardless of which channels these messages are on.

Mode 2. Omni On, Mono. In this mode a device can only play one note at a time but responds to all MIDI



channel messages.

Mode 3. Omni Off, Poly. In this mode a device is able to play more than one note at a time on any chosen
channel. This is the most common mode and is useful with sequencers.

Mode 4. Omni Off, Mono. In this mode a device can only play one note per channel. This mode is useful
with guitar controllers where each string can be assigned a separate channel.






Views

Control Bar
Track View
Score
PianoRoll

Drum

Event List
Controllers

Quantize

Time Signature

Key Signature



Keyboard Shortcuts

Space
Left
Right
Home
End
Del

F1

Ctrl+R
Ctrl+N
Ctrl+O
Ctrl+S
Ctrl+A
Ctrl+U
Ctrl+T
Ctrl+C
Ctrl+P

Ctrl+Tab
Ctrl+Shift+Tab
Ctrl+F4
Alt+F4

Play/Stop

Rewind

Fast Forward

Change the position to the beginning of the song
Change the position to the end of the song
Delete the selected events

Help

Record

Start a new song

Open a file

Save the current song

Save the current song using a new filename
Undo or redo the last change

Go to a new time

Cycle

Punch In

Next child window
Previous child window
Close child window
Exit



Support

Support is available by e-mail at

amcsoftware@kagi.com

For the latest information on Digital Studio visit

www.kagi.com/amcsoftware



File Menu

The File Menu includes commands to open and save files and to print a score.
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——Save As

——Printer Setup

——Print Options

Print Preview

Print



Edit Menu

The Edit Menu includes commands to edit segments and tracks. Most of the segment commands will only
be available if a segment is highlighted in the Track View.
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Create Segment

Delete Segment

Repeat

Split

Combine

Transpose

Move Track

Delete Track



View Menu

The View Menu includes commands to open a graphical or list view. The Score, Piano Roll, Drum, Event
List, Controllers and Quantize commands are only available if a segment is highlighted in the Track View.

Score
Piano Roll

Drum

——FEvent List
Controllers

——Quantize

—— Time Signature

— Key Signature



MIDI Menu

The MIDI Menu includes commands to change MIDI settings and to edit Instrument Maps and System
Exclusive Setups.

——MIDI Devices

—— Settings
—MIDI Thru

——Synchronization
Metronome

—Instrument Map
Define Instruments

Define Names

——System Exclusive

— System Exclusive Setup



Go To Menu

The Go To Menu includes commands to change the position in the song.

Time

Beginning
End




Options Menu

The Options Menu includes commands to change the display of the views available in the View Menu.
Track View
Score
Piano Roll

Drum

——FEvent List

Mixer

American Note Names



Window Menu

The Window Menu includes commands to change how the windows are displayed.

Cascade

Tile

Arrange Icons

Close All



New (File Menu)

This removes the current song from memory. If there are any unsaved changes, you will be given the
chance to save.



Open (File Menu)

This allows you to load a song from disk, replacing the current song in memory. If there are any unsaved
changes, you will be given the chance to save.

You can load Standard MIDI files (.mid) or Digital Studio files (.dst).

You can also load a song by selecting a file from the recently used file list at the bottom of the File menu.



Save (File Menu)

This saves the current song to disk using the current file name. If the current song is new and has no file
name then you will be prompted with the Save As dialog box.



Save As (File Menu)

This allows you to save the current song to disk under a different file name.

You can save the song as a Standard MIDI file (.mid) or a Digital Studio file (.dst). Songs saved as a
Standard MIDI file can be loaded into most other MIDI software programs but songs saved as a Digital
Studio file can only be loaded by this program.



Printer Setup (File Menu)

This allows you to choose your printer and configure it.



Print Options (File Menu)

This allows you to decide what you want to print.

Track. This is the track from which the score will be printed. The score will comprise of all the segments
on the track put together.

Copies. The number of copies of the score to be printed.

Title. This is printed at the top of the first page.

Composer. This is printed on the right side of the first page below the title.

Instrument. This is printed on the left side of the first page below the title.

Print Range. This allows you to select either the whole track or a range of bars in the track.

Other options such as which clef to use and the resolution of the notes can be changed in the Score
Options dialog box.




Print Preview (File Menu)

This gives a preview of how the printout will appear.



Print (File Menu)

This prints the score from the track selected in Print Options.

Other options such as which clef to use and the resolution of the notes can be changed in the Score
Options dialog box.



Undo (Edit Menu)

This is used to undo the most recent change to the song. If this option is taken then the menu heading
changes to Redo and this allows you to reverse the undo change.

A description of the most recent change is also added to the menu heading.



Create Segment (Edit Menu)

This allows you to create an empty segment.



Delete Segment (Edit Menu)

This deletes the segment that is currently highlighted in the Track View.



Repeat (Edit Menu)

This allows you to repeat the segment that is currently highlighted in the Track View. The new segments
are all clones of the highlighted segment and are repeated straight after it.



Split (Edit Menu)

This allows you to split the segment that is currently highlighted in the Track View into two new segments.



Combine (Edit Menu)

This combines the segment that is currently highlighted in the Track View with the next segment in the
track. If the highlighted segment is the last segment in the track then no action takes place.



Transpose (Edit Menu)

This allows you to transpose all the notes in the segment that is currently highlighted in the Track View. A

positive number will increase the pitch of the notes whereas a negative number will decrease the pitch of
the notes.

It is also possible to transpose the notes as they are being played in the Track View, Track Settings dialog
box or the Segment Settings dialog box. In this case the value of the notes in memory will not change.



Move Track (Edit Menu)

This allows you to move a track and all its segments to another track. The other tracks will be moved to
make way for this track.



Delete Track (Edit Menu)

This allows you to delete a track and all its segments. The settings for this track will also be removed.



Score View (View Menu)

This displays the Score for the segment that is currently highlighted in the Track View.
Tools

The arrow is used to do most of the editing. If the mouse button is clicked on a note then that note
becomes highlighted and the values of the note are displayed in the information boxes. If the left mouse
button is clicked elsewhere then a note will be inserted at that point. If the left mouse button is clicked on
a note and then dragged the note will be moved to a new position. If the right mouse button is clicked on a
note and then dragged a copy is made of the original note and placed in the new position when the button
is released.

The eraser is used to delete notes. Press the left mouse button and then drag over any notes to be
deleted.

This displays the Score Options dialog box. This is used to change how the score is displayed. It only
changes the options for this window. If Score Options is chosen from the menu bar then that only effects
how all future Score windows will be displayed.

The cursor changes to this when it is over the position indicator. It can then be dragged to a new position.

When a note is highlighted it turns blue and the values of the note are displayed in the information boxes.
These can be changed by placing the cursor over a value and pressing the left mouse button to decrease
the value and the right mouse button to increase the value. If one button has been pressed, pressing the

other while keeping the first button pressed will make the values change in bigger steps.



Piano Roll View (View Menu)

This displays the Piano Roll for the segment that is currently highlighted in the Track View.
Tools

The arrow is used to do most of the editing. If the mouse button is clicked on a note then that note
becomes highlighted and the values of the note are displayed in the information boxes. If the left mouse
button is clicked elsewhere then a note will be inserted at that point. If the left mouse button is clicked on
a note and then dragged the note will be moved to a new position. If the right mouse button is clicked on a
note and then dragged a copy is made of the original note and placed in the new position when the button
is released.

This is used to select more than one note at a time. Press the left mouse button and drag the mouse to
create a box. All the notes inside this box become selected when the button is released. If the left mouse
button is clicked inside the box and then dragged all the notes inside the box are moved. If the right
mouse button is clicked inside the box and then dragged all the notes are copied to the new position.

The eraser is used to delete notes. Press the left mouse button and then drag over any notes to be
deleted.

This displays the Piano Roll Options dialog box. This is used to change how the view is displayed. It only
changes the options for this window. If Piano Roll Options is chosen from the menu bar then that only
effects how all future Piano Roll windows will be displayed.

The cursor changes to this when it is over the end of a note. It can then be dragged to decrease or
increase the length of the note.

The cursor changes to this when it is over the position indicator. It can then be dragged to a new position.

When a note is highlighted it turns blue and the values of the note are displayed in the information boxes.
These can be changed by placing the cursor over a value and pressing the left mouse button to decrease
the value and the right mouse button to increase the value. If one button has been pressed, pressing the

other while keeping the first button pressed will make the values change in bigger steps.

At the bottom of the window is the controllers pane. This can either display the velocities of the notes or
any of the controllers. This is chosen from the Piano Roll Options dialog box. By pressing the left mouse
button in this pane and then dragging a red area will be drawn. If the velocities of the notes are shown
then any notes that occur in this area will have their velocities changed to the height of the area. If a
controller is displayed then new events for this controller will be inserted every time the height of the area
changes.



Drum View (View Menu)

This displays the Drum View for the segment that is currently highlighted in the Track View.
Tools

The arrow is used to do most of the editing. If the mouse button is clicked on a note then that note
becomes highlighted and the values of the note are displayed in the information boxes. If the left mouse
button is clicked elsewhere then a note will be inserted at that point. If the left mouse button is clicked on
a note and then dragged the note will be moved to a new position. If the right mouse button is clicked on a
note and then dragged a copy is made of the original note and placed in the new position when the button
is released.

This is used to select more than one note at a time. Press the left mouse button and drag the mouse to
create a box. All the notes inside this box become selected when the button is released. If the left mouse
button is clicked inside the box and then dragged all the notes inside the box are moved. If the right
mouse button is clicked inside the box and then dragged all the notes are copied to the new position.

The eraser is used to delete notes. Press the left mouse button and then drag over any notes to be
deleted.

This displays the Drum Options dialog box. This is used to change how the view is displayed. It only
changes the options for this window. If Drum Options is chosen from the menu bar then that only effects
how all future Drum windows will be displayed.

The cursor changes to this when it is over the position indicator. It can then be dragged to a new position.

When a note is highlighted it turns blue and the values of the note are displayed in the information boxes.
These can be changed by placing the cursor over a value and pressing the left mouse button to decrease
the value and the right mouse button to increase the value. If when one button has been pressed,
pressing the other while keeping the first button pressed will make the values change in bigger steps.

At the bottom of the window is the velocities pane. This displays the velocities of the notes. By pressing
the left mouse button in this pane and then dragging a red area will be drawn. Any notes that occur in this
area will have their velocities changed to the height of the area.



Event List View (View Menu)

This displays the Event List for the segment that is currently highlighted in the Track View.

Adding an event.
Enter the new event, its parameters and at what time it is to occur and press the Add button.

Changing an event.

Enter the new event, its parameters and at what time it is to occur and press the Change button. The
event that is currently highlighted in the list box will be changed to the new event.

Deleting an event.
Highlight the event in the list box that you want to delete and press the Delete button.

The type of events that are displayed can be changed in the Event List Options dialog box.



Controllers View (View Menu)

This displays the Controllers view for the segment that is currently highlighted in the Track View.
The events are only displayed for the controller selected in the combo box.

Adding an event.
Enter the new value and at what time it is to occur and press the Add button.

Changing an event.
Enter the new value and at what time it is to occur and press the Change button. The event that is
currently highlighted in the list box will be changed to the new event.

Deleting an event.
Highlight the event in the list box that you want to delete and press the Delete button.



Quantize View (View Menu)

This displays the Quantize view for the segment that is currently highlighted in the Track View.

This allows you to adjust the times of events to the nearest position specified in the resolution combo box.
The strength determines how far the event will be moved. A higher value will move the event by a greater
time. The from and to times allow you to specify the exact section for which the quantization is to occur.

The times of the events in memory are not changed but are adjusted as they are being played. This
means that you can change the quantization as much as you like while always keeping the original timing
of what was recorded.

Adding a quantize period.
Enter the new resolution and strength and at what time period it is to occur and press the Add button.

Changing a quantize period.
Enter the new resolution and strength and at what time period it is to occur and press the Change button.
The quantize period that is currently highlighted in the list box will be changed to the new quantize period.

Deleting a quantize period.
Highlight the quantize period in the list box that you want to delete and press the Delete button.



Mixer (View Menu)

The mixer contains controls for each track. On each track there is a slider and three knobs. The slider
controls the volume for the track while each knob is user-defined and can be set in the Mixer Options
dialog box.

During playback it is possible to record any changes you make to the controls. It is also possible for the
controls to move during playback in response to any changes that have been made previously. These
options can be set in the Mixer Options dialog box.

If an initial volume or pan has been set for a track in the Track View and the Update Mixer option is on,
then at the beginning of the song the mixer controls will be set to these initial values.



Tempo View (View Menu)

This displays all the tempo changes in the song.

Adding a tempo.

Enter the new tempo and at what time it is to occur and press the Add button. If a tempo already exists at
this time you will be asked if you want to replace it.

Changing a tempo.
Enter the new tempo and at what time it is to occur and press the Change button. The tempo change that
is currently highlighted in the list box will be changed to the new tempo.

Deleting a tempo.
Highlight the tempo change in the list box that you want to delete and press the Delete button.

There must always be an initial tempo and so you will not be allowed to delete it or change it to occur at a
new time.



Time Signature View (View Menu)

This displays all the time signature changes in the song.

Adding a time signature.
Enter the new time signature and at what time it is to occur and press the Add button. If a time signature
already exists at this time you will be asked if you want to replace it.

Changing a time signature.
Enter the new time signature and at what time it is to occur and press the Change button. The time
signature change that is currently highlighted in the list box will be changed to the new time signature.

Deleting a time signature.
Highlight the time signature change in the list box that you want to delete and press the Delete button.

There must always be an initial time signature and so you will not be allowed to delete it or change it to
occur at a new time.

Note that time signatures can not be changed in the middle of a bar.



Key Signature View (View Menu)

This displays all the key signature changes in the song.

Adding a key signature.
Enter the new key signature and at what time it is to occur and press the Add button. If a key signature
already exists at this time you will be asked if you want to replace it.

Changing a key signature.
Enter the new key signature and at what time it is to occur and press the Change button. The key
signature change that is currently highlighted in the list box will be changed to the new key signature.

Deleting a key signature.
Highlight the key signature change in the list box that you want to delete and press the Delete button.

There must always be an initial key signature and so you will not be allowed to delete it or change it to
occur at a new time.

Note that key signatures can not be changed in the middle of a bar.



MIDI Devices (MIDI Menu)

This allows you to choose which input and output devices to use.

Highlight the devices that you wish to use and press the OK button. If any of the devices are in use by
another application or by the MIDI Mapper then a message will be given that the device could not be
opened. In this case either deselect the device or close the application that is using the device.

In order for playback to work at least one output device must be selected and for recording to work at
least one input device must be selected.



MIDI Settings (MIDI Menu)

This allows you to change various MIDI settings.

Channel Filter. This is used to specify the channels for which MIDI data is accepted when recording or
when MIDI Thru is enabled. If the box is checked then data is accepted, otherwise it is ignored.

Record Filter. This is used to specify what events will be accepted when recording or when MIDI Thru is
enabled. If the box is checked then the event is accepted, otherwise it is ignored.

Timing Precision. This is used to specify how accurate the timing is on playback. The higher the
precision, the more work the computer has to do. If playback appears sluggish then try a lower precision.
This should only happen on slower machines.

Timebase. This is the number of ticks per quarter note. Higher values give more precision but the
computer has to work harder.

Multitrack Record. If you want to record onto more than one track at once then check this box. If this box
is checked then two columns are added in the Track View. These two columns allow you to specify the
input port and channel for each track.

Reset Controllers. If this box is checked then when playback is stopped, controllers such as pitch bend
wheels and modulation wheels are set to zero on each channel.

Chase Events. If this box is checked then when playback begins all instruments are set to their correct
settings at the playback position. This includes patch changes and all controller changes.



MIDI Thru (MIDI Menu)

This allows you to enable MIDI Thru. When this is enabled then all MIDI input will be echoed to the output
port and channel specified. Events can be filtered using the Channel Filter and Record Filter in the MIB}-
SettingsSETTINGS dialog box.



Synchronization (MIDI Menu)

This allows you to specify if another device should be synchronized to Digital Studio and the SMPTE
frame rate.

MIDI Clock and MIDI Timecode are sent to all output devices. If Digital Studio is being synchronized to
another device then this is set in the Control Bar.

The SMPTE frame rate is used for sending MIDI Timecode and receiving MIDI Timecode. Make sure that
it is the same as the frame rate on the external device.



Metronome (MIDI Menu)

This allows you to set the metronome parameters.

It is possible to have different settings for the first note in each bar. This is so that the first note can be
emphasized.

Check the record switch to hear the metronome during recording and similarly, check the playback switch
to hear the metronome during playback.

The count-in is the number of beats that will be played before either recording or playback begins.



Instrument Map (MIDI Menu)

This allows you to set an instrument definition for each channel on each output port.

Each instrument definition is assigned a default set of 128 patch names. If the instrument supports bank
changes then the instrument can also be assigned a set of patch names for each bank.

These can be setup in the Define Instruments dialog box. The Patch Names can be edited in the Define
Names dialog box.



Define Instruments (MIDI Menu)

This allows you to set Patch Names for a particular instrument.

Adding an instrument definition.
Enter the name in the instrument edit box and press the New button. Each name should be unique.

Renaming an instrument definition.
Select the instrument definition in the combo box that you wish to rename. The name for that instrument
definition will appear in the edit box. Change that to the new name and press the Rename button.

Copying an instrument definition.

Select the instrument definition in the combo box that you wish to copy. The name for that instrument
definition will appear in the edit box. Change that to the new name and press the Copy button. The new
instrument definition will be exactly the same as the one it has been copied from.

Deleting an instrument definition.
Select the instrument definition in the combo box that you wish to delete and press the Delete button.

Changing the patch names assigned to an instrument.
Select the instrument definition in the combo box. Then select the new set of patch names from the Patch
Names combo box.

Adding a set of patch names to a bank.
Enter the bank and select the patch names for that bank. Press the Add button and a set of patch names
for the bank will be added to the list box.

Changing a set of patch names for a bank.
Select which bank you want to change from the list box. Select the new set of patch names and press the
Change button.

Deleting a set of patch names from a bank.
Select which bank you want to delete the patch names from in the list box and press the Delete button at
the bottom of the dialog box.

Setting up a set of patch names for a bank overrides the general set of patch names for the instrument if
that bank is selected in the Track View. If a bank is selected and no set of patch names exist for that bank
then the general set of patch names for the instrument will be used.

Instruments can be assigned to any channel on any output port in the Instrument Map dialog box. The
patch names can be edited in the Define Names dialog box.



Define Names (MIDI Menu)

This allows you to edit the patch names and drum names.

To edit the patch names select the Patch Names radio button. All the patch name sets will be then be
displayed in the combo box. By selecting a patch name set in the combo box all the patch names for that
set will be displayed in the list box at the bottom of the dialog box. Similarly, to edit the drum names select
the Drum Names radio button.

Adding a new set of names.
Enter the name for this set in the edit box and press the New button. Each name should be unique.

Renaming a set.
Select the set in the combo box that you wish to rename. The name for that set will appear in the edit box.
Change that to the new name and press the Rename button.

Copying a set of names.

Select the set in the combo box that you wish to copy. The name for that set will appear in the edit box.
Change that to the new name and press the Copy button. The new set of names will be exactly the same
as the one it has been copied from.

Deleting a set of names.
Select the set in the combo box that you wish to delete and press the Delete button.

Renaming a patch or drum name.

Select the name in the list box to be renamed. That name will appear in the edit box at the bottom of the
dialog box. Change that to the new name and press the Rename button.

The patch names are used in the Track View and the drum names are used in the Drum View.



System Exclusive (MIDI Menu)

This allows you to send and receive system exclusive data.

System exclusive data can be used to give you more control over your synthesizer than with normal MIDI
messages. Unlike normal message system exclusive messages are specific to each manufacturer's
products. System exclusive messages can be used to store many types of information such as patch
parameters, rhythm patterns and an instrument's system area.

System exclusive data is received by either sending a request string to an instrument which tells it to send
information directly from the instrument. If a request string is being used then it is sent to the port
specified in the output section of the dialog box. The system exclusive data is received from the port
specified in the input section of the dialog box. Once the data has been stored it can then be sent back to
the instrument.

Request strings are different for each instrument. Your instrument's manual should give details about the
request strings it accepts. System exclusive request strings can be changed in the System Exclusive
Setup dialog box.

Receiving system exclusive data.

Select which system exclusive request string is to be sent in the input list box. This is sent to the port in
the output port combo box. Also select the port in the input port combo box which will be used to receive
the system exclusive data. Press the Receive button and the number of bytes received will be shown.
When all the data has been received press the Done button. This data will then be added to the output list
box.

Sending system exclusive data.

Select which bank of data is to be sent in the output list box. Also select the port to which it is to be sent.
Press the Send button to send the data.

To send all the banks of data press the Send All button.



System Exclusive Setup (MIDI Menu)

This allows you to setup the system exclusive request strings which are used to receive system exclusive
data.

Editing the request strings.
Select the request string to be edited and press the Edit button. A dialog box will then be displayed
allowing you to edit the data. The request string must consist of hexadecimal numbers starting with FO

and ending with F7. Your instrument manual should give a listing of system exclusive commands for your
device.



Time (Go To Menu)

This allows you to go to a specific time.



Beginning (Go To Menu)

This takes you to the beginning of the song.



End (Go To Menu)

This takes you to the end of the song.



Track View Options (Options Menu)

This enables you to change the options for the Track View.

Copy segments as clones. If this is checked then when the right mouse button is used to copy a
segment the new segment is a clone of the original.

Snap. When a segment is moved using the mouse this value decides what time the beginning of the
segment will be rounded to.



Score Options (Options Menu)

This enables you to change the options for the Score view. These options also affect how the score will
be printed.

Snap. When a note is moved using the mouse this value decides what time the note will be rounded to.
Clef. This is the clef that will be displayed.

Split. If a treble clef and a bass clef is displayed then all the notes above and including this note is
displayed on the treble clef and all the notes below this note is displayed on the bass clef.

Note resolution. This determines the resolution of how the notes are displayed. This can be set
individually for both triplets and non-triplets.

Rest resolution. This determines the resolution of how the rests are displayed. This can be set
individually for both triplets and non-triplets.

The score looks cleaner with higher resolutions. If there are no triplets in the song then it is best to set the
triplet note resolution to off.

Insert Note. When a note is inserted, the length, velocity and off-velocity of the note are taken from these
values.



Piano Roll Options (Options Menu)

This enables you to change the options for the Piano Roll view.

Snap. When a note is moved using the mouse this value decides what time the note will be rounded to.
Grid. The resolution of the grid overlaid on the display.

Controller. The type of controller that is displayed at the bottom of the piano roll view.

Insert Note. When a note is inserted, the length, velocity and off-velocity of the note are taken from these
values.



Drum Options (Options Menu)

This enables you to change the options for the Drum view.
Snap. When a note is moved using the mouse this value decides what time the note will be rounded to.
Grid. The resolution of the grid overlaid on the display.

Drum Map. The map that is used to display the drum names. The names can be edited in the Define
Names dialog box.

Insert Note. When a note is inserted, the length, velocity and off-velocity of the note are taken from these
values.



Event List Options (Options Menu)

This enables you to select which type of events should be displayed in the Event List.



Mixer Options (Options Menu)

This enables you to change the options for the Mixer view.
Controllers. These are the controllers that are used in the display.

Record Mixer Movements. If this is checked then if the song is playing, any changes made in the Mixer
view will be recorded.

Update Mixer. If this is checked then during playback the mixer controls will be updated.



American Note Names (Options Menu)

This allows you to select whether to use American Note Names.

If this is selected then the following note names are used:-
Whole note, half note, quarter note, eighth note, sixteenth note, thirty-second note.

Otherwise the following note names are used:-
Semibreve, minim, crotchet, quaver, semiquaver, demisemiquaver.



Cascade (Window Menu)

This overlaps all the open windows leaving just the caption bar visible..



Tile (Window Menu)

This places all the open windows side by side.



Arrange Icons (Window Menu)

This arranges any icons(minimized windows) at the bottom of the window.



Close All (Window Menu)

This closes all the windows except the Track View which always remains open.



Track View

This display is split into two main parts, the Track Information and the Segment Display.

Track Information
This shows the following information for each track:-

Name. The name of the track. Double clicking on this displays the Track Settings dialog box.

Record. If this is selected then when recording, data will be sent to the track. If multitrack record is off
only one track can be selected for recording.

Solo. If this is selected then on playback no output will be sent from any other track.
Mute. If this is selected then on playback no output will be sent from the track.

Port. The output port where events from the track will be sent.

Channel. The channel where events from the track will be sent.

Bank. The initial bank for the track.

Patch. The initial patch for the track.

Volume. The initial volume for the track.

Pan. The initial pan for the track.

Transpose. This alters the pitch of all the notes on the track as they are being played. It does not change
them permanently.

Velocity+. This alters the velocity of all the notes on the track as they are being played. It does not
change them permanently.

Time+. This alters the time that events occur on the track as they are being played. It does not change
them permanently.

If multitrack record is on then two more options are shown:-
Record port. This is the port for which data will be received when recording.
Record channel. This is the channel on which data will be received when recording.

Use the left mouse button to decrease these values and the right mouse button to increase the values.

Segment Display.

If the mouse button is clicked on a segment then that segment becomes highlighted and the settings of
the segment are displayed in the information boxes. If the left mouse button is clicked on a segment and
then dragged the segment will be moved to a new position. If the right mouse button is clicked on a
segment and then dragged a copy is made of the original segment and placed in the new position when
the button is released.

If the left mouse button is pressed where there isn't a segment and the mouse is then dragged a box is
created. All the segments inside this box become selected when the button is released. If the left mouse
button is clicked inside this box and then dragged all the segments inside the box are moved. If the right
mouse button is clicked inside the box and then dragged all the segments are copied to the new position.



The cursor changes to this when it is over the end of a segment. It can then be dragged to decrease or
increase the length of the segment. All other instances of this segment also have their length changed. If
the length is decreased then events during the time difference will be lost.

The cursor changes to this when it is over the position indicator. It can then be dragged to a new position.

When a segment is highlighted it turns blue and the settings of the segment are displayed in the
information boxes. These can be changed by placing the cursor over a value and pressing the left mouse
button to decrease the value and the right mouse button to increase the value. If one button has been
pressed, pressing the other while keeping the first button pressed will make the values change in bigger
steps.

Double clicking on the name information box or on the segment will bring up the Segment Settings dialog
box.



Track Settings

This allows you to change various settings for a track.

Name. The name of the track.

Port. The output port where events from the track will be sent.
Channel. The channel where events from the track will be sent.
Bank. The initial bank for the track.

Patch. The initial patch for the track.

Volume. The initial volume for the track.

Pan. The initial pan for the track.

Transpose. This alters the pitch of all the notes on the track as they are being played. It does not change
them permanently.

Velocity+. This alters the velocity of all the notes on the track as they are being played. It does not
change them permanently.

Time+. This alters the time that events occur on the track as they are being played. It does not change
them permanently.



Segment Settings

This allows to you to change various settings for a segment.
Name. The name of the segment.

Bank. The initial bank for the segment.

Patch. The initial patch for the segment.

Volume. The initial volume for the segment.

Pan. The initial pan for the segment.

Transpose. This alters the pitch of all the notes in the segment as they are being played. It does not
change them permanently.

Velocity+. This alters the velocity of all the notes in the segment as they are being played. It does not
change them permanently.

Time+. This alters the time that events occur in the segment as they are being played. It does not change
them permanently.



Control Bar

Record. Start recording.

Beginning. Sets the position to the beginning of the song.
Rewind. Moves the position to an earlier time.

Fast Forward. Moves the position to a later time.

End. Sets the position to the end of the song.

Play. Start playback.

Stop. Stop playback.

Cycle. If this is selected then when the position reaches the right indicator it will move to the left indicator
and continue.

Punch In. If this is selected then when recording, only events received in the time between the left
indicator and right indicator will be recorded.

The displays are :-

Position. The current position of the song in bars:beats:ticks.

Time. The current time of the song in hours:minutes:seconds:frames.

Left. The position of the left indicator in bars:beats:ticks.

Right. The position of the right indicator in bars:beats:ticks.

Tempo. The current tempo.

Time Signature. The current time signature.

Clock. If Digital Studio is synchronized to an external device then set this to MIDI if the external device is
sending MIDI Clock messages or SMPTE if the external device if sending MIDI Timecode. Otherwise this
should be set to Internal.

Record Mode. When recording over events set this to Overdub to keep the old events or Replace to
delete the old events.






